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2 Window Layout

2.1 Basic Analysis Application Window Layout

2.2 Menu Bar

2.3 Main Toolbar

2.4 Tree View

2.5 Log View

2.6 Measurement Toolbar
2.7 Photometer Status

2.8 Parameter View

2.1 Basic Analysis Application Window Layout

The basic analysis application window comprises the following areas.

1- Spectrum(RF-01)-[View]
Parameter | ristory | Summary
Parameter Value
e_' 72728 T r—"
= 53 00624
12 8 C‘wec\od)e‘u L .”L . m m
/’ S— EM Wavelength Start  300.0nm
z 40000 —~ \‘ ::mm e ;o::“nm
E of i Scan Speed 500 rmjin
Message 20000} o ke \ (Instrument]
Shutter Motor Check - OK i e EXBandwidth 20m
Emissicn Side Siit Motor Che g B EM Bandwidth 10nm
Emission Side Grating Motor ﬁ:-g i X ) . Sensitvity Low
Total Judgment - OK 3000 3200 3400 %0.0 3800 400.0 [Attachment]
9_. Instrument Function Acquisi nm - 5 ™
Arc Lamp - mounted
Are Lamp - Total Lighting Ti Peak Pick  fiveshold 10 Painlz: 5 [ Execue [uto Print]
Mercury Lamp - unmounted Auto Print No
Integrating Sphere - Not Use No. | PV | Wavelength nm. | Intensity | Description | ReportFle
Sipper - Not Used 1 @ 3405 | 61332 |
Connection - Passed
9— [For Help, press F1
Basic Analysis Application Window Layout
No. Name Function
. Displays information including the application name, registered instrument
Q Title bar . .
name, and window mode ([Measurement] or [View]).
Displays the application menus. Selecting a menu along the bar displays
multiple command menus.
(2] Menu bar . . . .
The displayed command menus differ depending on the application type
and window mode.
o Main toolbar Displays tool buttons for executing main functions, such as file operations,
printing, and data processing.
Displays the open data file and the data set contained in this file in tree
. format.
(4] Tree view . . . o . .
Operations including switching the active data set and closing open files
can be performed.
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(5] Log view

Page 2 of 30

Displays logs that indicate the Photometer Status and operations
performed on the system as well as warnings.

(6 ) Application area

Displays a graph, data processing table, and information on the
measurement parameters.

The type of view displayed in the area and layout differ depending on the
application.

(7] Status Bar

The status bar is an area at the bottom of the active window that displays
information about the status of documents and contains other information,
such as the meaning of a command.

For example, when the mouse is pointed at a menu command, the status
bar provides a brief description of that menu command.

2.2 Menu Bar

The menu bar comprises menu items that are common between applications.

2.2.1 [Edit] Menu

2.2.2 [View] Menu

2.2.3 [Instrument] Menu

2.2.4 [Tools] Menu

2.2.5 [Window] Menu

22.6[H

elp] Menu

2.2.1 [Edit] Menu

Command Description
[Cut] Move the selected item to the clipboard.
[Copy] Copy the selected item to the clipboard.
[Paste] Paste the item on the clipboard to the selected position.
[Select All] Select all selectable items.

2.2.2 [View]| Menu

The commands displayed on this menu differ depending on the window mode.

! NOTE  The quantitation and photometric application windows do not have a view mode.

mMeasurement mode

Command Description
Tree View] Display or hide the tree view.
Log View] Display or hide the log view.

Status Bar]

Display or hide the status bar.

Measurement Toolbar]

Display or hide the measurement toolbar.

[
[
[
[
[

Parameters View]

Display or hide the parameter view.
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[Photometer Status]
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Display or hide the Photometer Status.

mView mode

Command Description
[Tree View] Display or hide the tree view.
[Log View] Display or hide the log view.
[Status Bar] Display or hide the status bar.
[Operation View] Display or hide the data processing area.
[Parameters View] Display or hide the parameter view.

mEdit printform mode

223

Command Description
[Tree View] Display or hide the tree view.
[Log View] Display or hide the log view.
[Status Bar] Display or hide the status bar.
[Properties View] Display or hide the properties for printable objects.
[Objects List] Display or hide the printable object view.
[Instrument] Menu
Command Description
Only available when connecting to the RF-6000 series.
Select the integrating sphere to use in measurement in the [Integrating Sphere]
window. This command is only available when an integrating sphere is installed on
[Integrating the instrument.
Sphere]
M Reference "[Integrating Sphere] window"
“, Hint If an integrating sphere is installed, an integrating sphere icon is shown on
the Photometer Status.
[Configure Configure settings related to the instrument in the [Configure Instrument] window.
Instmment] » Reference "[Configure Instrument] window"
Only available when connecting to the RF-5300PC series.
Displays the [Light Source Position Adjustment] window. The fluorescence
intensity is displayed in the window in real time. For details on the procedure for
adjusting the light source position, refer to the RF-5300PC instruction manual.
[Lamp Align]
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Arc Lamp lighting Time:

Light Source Position Adjustment

40 hours

0.074

Beset

LCloze

’ Hint

[Light Source Position Adjustment] Window

Clicking [Reset] changes the cumulative operating time of the lamp displayed
in the window to zero.

m[Integrating Sphere] window

Integrating Sphere

Do not use integrating sphere for measurement
@ Use integrating sphere for measurement

MNama

Serial Number
I5R-01 490255200000
OK ] | Cancel
[Integrating Sphere] Window
Item Description

[Do not use integrating
sphere for
measurement]

Select this setting when not using an optional integrating sphere.

[Use integrating sphere integrating sphere.

for measurement]

Select this setting when performing measurement using an optional

When this setting is selected, information on registered integrating spheres is
displayed in a list. When multiple integrating spheres are registered, click the
name of the integrating sphere to use in measurement in the list to select it.

m[Configure Instrument] window

* When connecting to the RF-5300PC series:
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Cenfigure Instrument

Maintenance

Auto Shutter:

Dark Current Correction:

Megative High—-PFressure Gontral:
PMT Protection: @ OM JOFF
Serial Mo; A40159390118654
ROM ersion: 32
[ ok | [ Fetnl |
[Configure Instrument] Window
Item Description

[Auto Shutter]

To prevent sample degradation or reaction, the sample must not be irradiated
with excitation light when measurement is not being performed.

» If [ON] is selected, the shutter is automatically opened only for
measurement to allow excitation light to irradiate the sample.

 If [OFF] is selected, the [Open] and [Close] shutter buttons on the
measurement toolbar must be used to manually open and close the shutter.

[Dark Current
Correction]

Click [Run] to perform dark current level correction and set the zero point.
The result of this operation is the same as closing the shutter and executing
[Auto Zero].

[Negative High-
Pressure Control]

If [ON] is selected, automatic correction of changes in fluorescence intensity
due to variations in xenon lamp power is performed. Normally perform
measurement with the [ON] setting. When the lamp is OFF, this setting is
automatically set to [OFF].

If [ON] is selected, the emission side slit automatically changes to the "Close"
state when the lid on the sample compartment is opened in order to prevent

[PMT Protection] outside light from damaging the photomultiplier. Normally perform
measurement with the [ON] setting.

[Serial No.] Displays the serial number of the connected instrument.

[ROM Version] Displays the firmware version of the connected instrument.

* When connecting to the RF-6000 series:

file:///C:/Users/Marcia/AppData/Local/Temp/~hh21AC.htm

28/6/2019



2 Window Layout Page 6 of 30

Configure Instrument

Auto Shutter: ) OFF

Dark Curent Comection: s 'JI Execute l

Arc Lamp: QN QFF

Serial No.: HZ2001412223

ROM Version: 1.00

[Configure Instrument] Window - [Maintenance] Tab

Item Description

To prevent sample degradation or reaction, the sample must not be irradiated
with excitation light when measurement is not being performed.

» If [ON] is selected, the shutter is automatically opened only for

[Auto Shutter] measurement to allow excitation light to irradiate the sample.

» If [OFF] is selected, the [Open] and [Close] shutter buttons on the
measurement toolbar must be used to manually open and close the shutter.

Select the integration time and click [Execute] to perform dark current level
correction and set the zero point. The result of this operation is the same as
closing the shutter and executing [Auto Zero].

To measure samples with low fluorescence intensity accurately, perform dark
current correction.

! NOTE . Dark current correction cannot be executed if the

[Dark Current sensitivity is set to Auto. Set the sensitivity to High or
Low when executing dark current correction. A dark

current correction value will be saved for both High and

Low settings.

Correction]

* To stabilize capturing of dark current correction data, set
the accumulation time parameter longer for dark current
correction. Set the parameter longer especially when the
instrument is unstable immediately after the power is
turned on.

Turn ON or OFF the xenon arc lamp used as the light source.
Although measurement is normally performed with the [ON] setting, select
the [OFF] setting when using an optional lamp.

[Arc Lamp]

! NOTE  When toggling from the [OFF] state to the [ON] state, the
instrument restarts automatically.

[Serial No.] Displays the serial number of the connected instrument.

[ROM Version] Displays the firmware version of the connected instrument.
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Configure Instrument
_Ligl'rt Source StatEi
Arc Lamp Lighting Time: 1092 hours Reset

Close

[Configure Instrument] Window - [Light Source Status] Tab

Item Description

[Arc Lamp Lighting Displays the operating time of the arc lamp. Click [Reset] to return the arc
Time] lamp operating time to zero.

2.2.4 [Tools] Menu

Command Description

[System Log]

Displays the [Configure System Log] window.
Use this window to configure automatic saving of log files and change the
[Configure] name of log files to be saved.

PP Reference "[Configure System Log] window"

Displays the [System Log] window.
A list of log files are displayed in this window.

PP Reference "[System Log] window"

Select a log file in the [Open Log File] window that appears. The [System
Log] window showing the details of the specified log file is displayed.

[View]

[Open]

Displays the [User Settings] window. Use this window to change the settings
of each application.

M Reference ¢ "[User Settings] window (spectrum application)"

¢ "[User Setting] window (3D spectrum application)"

[User Settings]

¢ "[User Settings] window (quantitation application)"

« "[User Settings] window (photometric application)"

¢ "[User Setting] window (time course application)"

¢ "[User Setting] window (edit print form)"

Set the destination folder of each file type in the [Destination Folder] window.
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Destination Folder

il

Data File: C:ARF-DatabData

Parameters File:  C:\RF-D atavParameters

afajajala

[Destination Folder] Template File:  C:ARF-DatahTemplate
Fepart File: C:\RF-Data%Report
Text File: C:ARF-DatahText
[ 0K ] | Cancel l

[Destination Folder] Window

This function is available only when connecting to the RF-6000 series.
Perform re-correction on any data file using the current correction function.

! NOTE  When re-correction is performed, the corrected data set
[Re-correction] ([CorrectionData)) in the data file is overwritten. Be aware
that data processing results such as for peak pick obtained
before the re-correction will be erased as well.

PP Reforencs [PDF Output ] tab"

Set the option name of the sample information in the [Sample Information
Settings] window.

Sample Information Settings @

[Optional sample

L X Label of Optional sample information: Option
information]

This modification is reflected after reactivation of software.

CK ] I Cancel |

[Sample Information Settings] Window

m[Configure System Log] window

Configure System Log @
Log File
File name: logfile.log
Destination Folder: C:\RF-Data\Log
Option

[¥] automatically change log file to maximum size

Maximum Size: 1000 = kB

oK ] l Cancel

[Configure System Log] Window
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Item
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Description

[File name]

Displays the name of the used log file.

[Destination Folder]

Displays the destination of the used log file.

[Automatically change
log file to maximum
size]

Select this checkbox to automatically change the log file when the specified
maximum size is exceeded.

[Maximum Size]

Set the maximum size of log files.

[OK]

Apply the system log settings and close the [Configure System Log] window.

[Cancel]

Cancel any changes to the system log settings and close the [Configure

System Log] window.

m[System Log] window

# | System Log - logfile.log @
Message DateTime User Name -
Arc Lamp - mounted 9/1/2015 7:19:32 PM
Connection - Passed 9/1/2015 7:19:32 FM
Instrument Function Acquisition - Passed 9/1/2015 7:19:32 FM
Integrating Sphere - Mot Used 9/1/2015 7:19:32 PM
Mercury Lamp - unmounted 9/1/2015 7:19:32 PM
Sipper - Not Used 9/1/2015 7:19:32 PM
Acquisiion of Initialization Results 9/1/2015 7:19:31PM
EEPROM Check - OK 9/1/2015 7:19:31PM
Emission Side Grating Motor Chedk - OK 9/1/2015 7:19:31FPM
Emission Side Slit Motor Check - QK 9/1/2015 7:19:31PM
Excitation Side Grating Motor Chedk - OK 9/1/2015 7:19:31PM
Excitation Side Slit Motor Check - OK. 9/1/2015 7:19:31FM
Hardware Configuration - OK 9/1/2015 7:19:31 PM
RAM Chedk - DK 9/1/2015 7:19:31 PM
ROM Check - OK 9/1/2015 7:19:31PM
Shutter Mator Check - OK 912015 7:19:31 FM a2
] [T 3
Text Output...

[System Log] Window

Item Description

Displays the details of the log. Log events including initialization result
information, status of the connected instrument, and starting and stopping of
measurement are displayed in real time.

[Event]

Indicates the date and time that the log event was generated.

! NOTE  The date and time that instrument initialization information
is obtained is displayed because this information is obtained
in bulk at the start of communication.

[Date/Time]

Nothing is displayed in the standard configuration. When using the optional
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[User Name]

automatically.

user management function, the user name of the logged in user is recorded

Page 10 of 30

[Text Output]

Save the log file information to a text file.

[Close]

Close the [System Log] window.

m[User Setting] window (common)

|Text File Formats]| tab
Set the delimiting character and type of quotation marks for text to use when outputting text files (.txt).

-
User Setting

Delimiter
Tab

© Comma
Space
Semicolon

Other

| General | Quick Print | Links Text File Formats | Text Output

=

Quotes for Text
@ Double Quote

Single Quote

None

oK ][ Canca |

[User Setting] Window - [Text File Formats] Tab

Item

Description

[Delimiter]

Select the delimiting character to use when outputting text files.

[Quotes
for Text]

Select the quotation marks to use for text when outputting text files.

[Text Output] tab
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User Settings

[l

| General | Quick Print [ Links | Text File Formats | Text Output | i

[ Create texd file automatically when data file is saved:

Conversion Condttions:
[¥] Including Summary

[¥] Including Parameters

File Conversion Type: ITe:d File - |

MNumber of Decimal Points (Wavelength): |1 -

Number of Decimal Pairts (Data): 3 &

oKk | [ Cancsl

[User Settings] Window - [Text Output] Tab

Item

Description

[Create text file
automatically when
data file is saved]

Select this checkbox to automatically convert data contained in data files to
text when the data file is saved and save the text to a text file in the specified
folder.

[File Conversion Type]

Select the format for saving text files.

[Conversion
Conditions]

[Including
Summary]

Add summary information regarding the data set or data file to the created
text file.

[Including
Parameters]

Add measurement parameter information of the data set or data file to the
created text file.

[Number of
Decimal Points
(Wavelength)]

Select the number of decimal places to use when converting wavelengths to
text.

[Number of
Decimal Points
(Data)]

Select the number of decimal places to use when converting data to text.

[PDF Output] tab

The [PDF Output] tab appears only when using the LabSolutions DB (CS) system in combination with
the optional LabSolutions DB (CS) Connection Kit.
The LabSolutions DB (CS) system outputs the print image as a PDF file when a data file is registered to
the database and manages them together.

Use the [PDF Output] tab to set a report file to be used for print image creation.
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User Settings

| General | Text File Formats | Quick Prnt | PDF Output | Text Output

Tare i

Calibration Curve File

Report File to Be Used:

FDFQuantitation frpt

Reset

[ ok ][ Camcel |

[User Settings] Window — [PDF Output] tab (Quantitaion)

Item Description
Tarect File Displays data file types for which a PDF file will be created (output) when the
g data file is registered in the database.

Displays a report file name linked to the target file and its save destination.

.

Report File to Be Used. ‘, Hint When there are multiple target files in the list, the report file name for
a selected (highlighted) data file is displayed.

Browse Displays the report file selection window.

Reset Return links to their initial state.

m[Recorrect] window

Recorrect
Data File:
[c:\RF-Data\Sample\RFsooo\sa_o 1.fs2f = ]
Correction Function:
{No Sphere v]
1087.09 ; : = ;
1000.00 B
z
£ 50000 -
E
0.00 B
-91.28 1 1 1 L
300.00 320.00 340.00 350.00 380.00 400.00
nm
x ) [cna

[Recorrect] Window
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Item Description

[Data File] Specify the data for performing re-correction.

Select the correction function to use in re-correction. When "No Sphere" is

[Correction Function] selected, the correction function of the currently connected instrument is
selected.

Displays the corrected spectrum of the selected data.

Graph Click [Recorrect] to display the re-corrected waveform in red superimposing
the current waveform.
Perform re-correction.

[Recorrect] Although the result (graph) after re-correction is displayed in the window,
selecting other data in this state will cause the re-correction result to be
discarded.

Accept the result of re-correction and close the [Recorrect] window.
B NOTE  The result of re-correction is updated to the data only when

[OK] [OK] is clicked to close the window. To perform re-

correction on multiple files, it must be performed by
opening the [Recorrect] window from the menu for each
file.

[Cancel] Cancel any settings made and close the [Recorrect] window.

2.2.5 [Window] Menu
Command Description
[View]/[Measurement] | Change between view mode and measurement mode.
[Edit Printform] Change to the edit print form mode window.
2.2.6 [Help] Menu
Command Description
[Help] Display the help top page.
Display LabSolutions RF version information.
About LabSolutions RF (23a]
LabSolutions RF
Wersion 1.00
Copyright € 2014 Shimadzu Corporation. Al Rights Reserved.
Thiz product is licensed to:
[AbOUt] Uszer
Shimadzu Corp.
‘Warning: this computer program is protected by copyright law and intermational
treaties.
Unauthorized reproduction or distribution of this program, or any portion thereof,
may rezult in zevere civil and criminal penalties, and will be progecuted to the
maximum extent possible under the law.
[About LabSolutions RF] Window
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2.3 Main Toolbar
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Save Print Preview

Main Toolbar (Quantitation/Photometric Applications)

Edt Printform

Item

Description

Open an existing data file.
Multiple files can be opened at once.

! NOTE  The mode automatically changes to view mode when a file

[Print Preview]

[Open] is opened.
:‘l' Hint The data file types that can be opened are the same as those that can be
opened from [Open] - [Data] on the [File] menu.
Other files can be opened from [Open] on the [File] menu.
[Save] Save by overwriting the currently open data file.
It is possible to switch between [Print] and [Print Preview] by clicking & on
the right.
[Print] * [Print]: Print the currently open data based on the settings of a report file.
or

* [Print Preview]: Display a preview of printer output based on the settings
of a report file.

M Reference "9 Editing Print Forms"

[Measurement] Change the window display to measurement mode.

[View] Change the window display to view mode.
Display the [Edit Printform] window.

[Edit Printform]
PP Reference "9 Editing Print Forms"
Displays the names of the two most recently selected data processing
operations.

[Operations] Clicking an operation in view mode executes the corresponding data
processing.
M Reference "8 Data Processing"

[Help] Displays the help top page.

2.4 Tree View

The tree view displays loaded data (files) in a hierarchical structure (tree structure). Closing a file
removes its display from the tree view and data area.

e 2.4.1 Spectrum/3D Spectrum/Time Course Applications

e 2.4.2 Quantitation and Photometric Applications

e 2.4.3 Active Data Set
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2.4.1 Spectrum/3D Spectrum/Time Course Applications

Perform measurement or open files to display data in the tree view and data area.

In the tree view, the data set name of data (raw data or corrected data) is displayed under the
hierarchical structure of the file, and when data is processed, newly created operation data is added at
the same level.

! NOTE < When performing spectrum (or 3D spectrum) measurement on the RF-6000 series,
spectrum correction is performed at the same time. This means that raw data
([RawData]) and corrected spectrum data ([CorrectionData]) are created in the file when
measurement is complete.

* On the RF-6000 series, [RawData] is not displayed in the tree view or graph view when
using the default settings because corrected spectrum data is treated as captured data (in
data processing etc.). To reference raw data, change the settings via [User Settings] on
the [Tools] menu.

H Reference e "[User Settings] window (spectrum application)"

e "[User Setting] window (3D spectrum application)"

¢ "[User Setting] window (time course application)"

e

|

-1 iICARF-Data\Data\EMSpc_003.fs2f:

VI RawData

[VIH CorectionData

=¥y’ CARF-Data\Data\EMSpc_002.fs2f
VIEH RawData

V|5 CorectionData

o &

Tree View (Spectrum Application)

No. Item Description

Displays the data filename.
Click [Show Full Path] on the right-click menu to switch to path display.

(1) Filename * Select the checkbox to display all data within the file.
* Deselect the checkbox to hide all data within the file.

T indicates that the file has not been saved.

Displays the data set name of the raw (measurement) data.
Use the checkbox to display or hide a graph on the [Overlay] tab.

« ¥ :Indicates that the graph line is hidden.

. : Indicates the line color displayed on the graph.
(2] [RawData] = ey grap

! NOTE  Because corrected data is displayed on the RF-6000
series, raw data is not displayed on the tree view by
default.

Only available on the RF-6000 series.
Displays the data set name after spectrum correction.
Use the checkbox to display or hide a graph on the [Overlay] tab.

* ¥ :Indicates that the graph line is hidden.
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« [ : Indicates the line color displayed on the graph.

CorrectionData
o [ ] ! NOTE  On the RF-6000 series, spectrum correction is

performed together with measurement.

Displays the data set name edited (or created) in a data operation.
Use the checkbox to display or hide a graph on the [Overlay] tab.

[Dataset . ¢ ¥ :Indicates that the graph line is hidden.
(4] XXXXXX] (Edit
data) « B : Indicates the line color displayed on the graph.

“t’ Hint The active data set, which is targeted for data processing and
saving, is highlighted in blue.

mFile operations in the tree view

Operation Description

Display or hide the corresponding data in the tree view.
E?tcgf[gl]e(gliﬂ;;;he * Click [+] to display table lower in the hierarchy.

* Click [-] to hide table lower in the hierarchy.

Double-click on a filename to display or hide the corresponding data in the
Double-click tree view.
Double-clicking the data set name changes it to the active data set.

Right-click on a filename to execute the following menu commands.

* [Show Full Path]: Switch to "full path filename display" or "filename only
display" in the tree view only.
Right-click .
* [Close]: Close the file and remove it from memory.
Right-click on a data set name to execute the following menu command.

 [Text File Output]: Convert and save data to a text file.

This function only applies to 3D spectra.
When the graph area is set to tiled display, drag a data set name to any tile
position to display contour plot graph for the data.

Drag
(only for data sets)

2.4.2 Quantitation and Photometric Applications

The tree view structure for the quantitation and photometric applications is shown below.

! NOTE  Only the sample table is displayed in the photometric application.

| 1
=g CARF-Data\Data\intD ata_001.fqqf

e § Standard Table [

() Sample Table

Tree View (Quantitation Application)

No. Item Description

o Filename

Displays the filename of the open data.
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Click [Show Full Path] on the right-click menu to change the path display.

(2] Table names Displays the table names contained in the open data.

mFile operations in the tree view

Operation Description

Display or hide the corresponding data in the tree view.
Click [+] or [-] to the T . . .
left of the filename Click [+] to display tables lower in the hierarchy.

* Click [-] to hide tables lower in the hierarchy.

Double-clicking the table name changes it to the active table.

Click -
, Hint Click [Start] to perform measurement of the active table.

Right-click on a filename to execute the following menu commands.

* [Show Full Path]: Switch to "full path filename display" or "filename only
display" in the tree view only.

Right-click

* [Close]: Close the file and remove it from memory.

* [Text File Output]: Convert and save the quantitation (or photometric) file
to a text file.

2.4.3 Active Data Set

The active data set is the data set that is currently targeted for processing.

Before performing operations such as data processing, file saving, and text output, double-click on the
target data set in the tree view to make it active.

The active data set is highlighted in blue in the tree view.

M Reference "2.4 Tree View"

2.5 Log View

Message Date/Time User Mame =
Shutter Motor Check - OK 9/1/2015 8:02:38 PM
Emission Side Slit Motor Check - OK 9/1/2015 8:02:38 PM
Emission Side Grating Motor Check - OK 9/1/2015 8:02:38 PM
Total Judgment - OK 9/1/2015 8:02:38 PM
Instrument Function Acquisition - Passed 9/1/2015 8:02:39 PM
Arc Lamp - mounted 9/1/2015 8:02:39 PM
Arc Lamp - Total Lighting Time: 1093[hours]  9/1/2015 8:02:39 PM
Mercury Larmp - unmounted 9/1/2015 8:02:39 PM 3
Integrating Sphere - Mot Used 9/1/2015 8:02:39 PM
Sipper - Not Used 9/1/2015 8:02:39 PM
Connection - Passed 9/1/2015 8:02:39 PM
] (T : ’
Item Description
[Message] Displays the details of the log. Log events including initialization result
information, status of the connected instrument, and starting and stopping of
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measurement are displayed in real time.

Indicates the date and time that the log event was generated.

[Date/Time] ! NOTE  The date and time that instrument initialization information
is obtained is displayed because this information is obtained
in bulk at the start of communication.

Nothing is displayed in the standard configuration. When using the optional
[User Name] user management function, the user name of the logged in user is recorded
automatically.

! NOTE  The log view is limited to displaying a maximum of 1,000 events. When 1,000 events is
exceeded, the oldest event is deleted to make way for the latest event.

'?' Hint To view previous log information, click [System Log] - [View] on the [Tools] menu.

M) Reference "[System Log] window"

2.6 Measurement Toolbar

¥/ L7 7] set fi tomatical o at
7, 4'@" .:I] v 7 [#]5et file name automatically =
Stop Open Go To WL | | Auto Zero Search AutoFile_001.fs2f ik

Measurement Toolbar (Spectrum/3D Spectrum/Time Course Applications)

Sipper

= : Open... | Save As... =1 3
g | [0 B | (s e H
Stop Open Auto Zero Search 3 Puge | File Name: QntData_001.fquf - Disconnect
Measurement Toolbar (Quantitation/Photometric Applications)
Item Description
[Start] Start measurement.
[Stop] Stop measurement.

[Open]/[Close] (shutter) Open or close the shutter.

Display the [Wavelength setting] window and move the excitation
[Go To WL] wavelength and fluorescence wavelength.

PP Reference "2.6.1 [Wavelength setting] Window"

Set the fluorescence intensity to zero in the current state (wavelengths,

[Auto Zero] instrument parameters, shutter open/close etc.).
Display the [Search Optimal Wavelength] window and search for the
optimal excitation wavelength and fluorescence wavelength.
This button is disabled when the optional flash lamp is installed.
[Search]

» Referance * RF-5300 series: "2.6.2 [Search Optimal Wavelength] Window"

¢ RF-6000 series: "2.6.3 [Perform Search] Window"

This button is enabled when the optional sipper is connected.

[Sip] (sipper) Clicking this button causes the sipper to perform a sipping operation for the
duration of the sipping time set under [Attachment] in the measurement
parameters. This is used for washing the sipper cell or filling the cell with
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blank solution.

[Purge] (sipper)

This button is enabled when the optional sipper is connected.

Clicking this button causes the sipper to perform a purging operation for the
duration of the purging time set under [Attachment] in the measurement
parameters. This is used when discharging the blank solution filled in the
sipper cell.

[Set file name
automatically]

Select this checkbox to generate filenames automatically according to the
settings registered in the [Configuration] window.

>> (auto file function)

Display the [Settings] window of the auto file function.

» Reference 2 6 4 [Settings] Window (Auto File Function)"

Filename display

Displays the filename for creation/saving in the next measurement when the
[Set file name automatically] checkbox is selected.

[Open] Open a template file.
[Template]

Efsve Save the current state as a template file.
[File Name]/[Photometric | Displays the filename used when saving or the name of the currently loaded
File] data file.

>> (set file)

Set the quantitation or photometric file.

The [Quantitation File Setting] window is displayed in the quantitation
application and the [Photometric File Setting] window is displayed in the
photometric application.

PP Reference "[New Data Set] Window"

[Connect]/[Disconnect]

Connect to or disconnect from the instrument.

2.6.1 [Wavelength setting] Window

[ ]
o 2.6.2 [Search Optimal Wavelength] Window
e 2.6.3 [Perform Search] Window
o 2.6.4 [Settings] Window (Auto File Function)
e 2.6.5 [Quantitation File Setting] Window/[Photometric File Setting] Window
2.6.1 [Wavelength setting] Window
rWachength setting

Excitation Wavelength(nm): 1350.0] =

Emission Wavelength(nm): 350.0 =

Emission Intensity: =00

[ Move I [ Cancel

[Wavelength setting] Window

Item Description
P Set the excitation wavelength.

[Excitation . i .
Effective range: 220.0 to 900.0 (RF-5300 series), 200.0 to 900.0 (RF-6000

Wavelength] .
series)
Set the fluorescence wavelength.

[Emission Wavelength] | Effective range: 220.0 to 900.0 (RF-5300 series), 200.0 to 900.0 (RF-6000

series)
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2.6.2

2.6.3

[Emission Intensity]

Page 20 of 30

After moving to the set wavelength, the fluorescence intensity is read and
displayed.

[Move]

Move to the set wavelength.

[Close]

Close the [Wavelength setting] window.

[Search Optimal Wavelength] Window

When connecting to the RF-5300 series, this window is displayed by clicking [Search] on the

measurement toolbar.

Search Optimal Wavelength

Exditation Search Range:

Emission Search Range:

Exdtation Search Interval:

- .
Optimal Wavelength:
Excitation Wavelength:

Emission Wavelength:

220 £

34/170 seconds

S nm

LI nm

500 nm

00 nm

nm

[Optimal Excitation/Emission Wavelength Search] Window

Item

Description

[Excitation Search
Range]

Set the excitation wavelength range to search.
Effective range: 220 to 900 nm (only integer value input accepted)

[Emission Search
Range]

Set the fluorescence wavelength range to search.
The start value for excitation is displayed as the start value (cannot be input).
Effective range: 220 to 900 nm (only integer value input accepted)

[Excitation Search
Interval]

Set the excitation wavelength interval to search.
Effective range: 10 to 99 nm (only integer value input accepted)

Progress bar

Displays the progress of the search. (Elapsed time/estimated completion time
in seconds)

After clicking [Execute], the optimal wavelengths are displayed once they

[Optimal Wavelength] have been determined.

Execute processing to determine the optimal wavelengths in the set
[Execute] wavelength ranges.
[Close] Close the [Search Optimal Wavelength] window.

[Perform Search] Window

When connecting to the RF-6000 series, this window is displayed by clicking [Search] on the

measurement toolbar.
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-
Perform Search

-[ Search Range: |to 500 nm

S ][Intensity Minimum: 0

Maximum: 300 Set ]—_9

-

EM Wavelength{nm)/EX Wavelength(nm)

500

200 250 300 350 400 450 500 9
EM:342.0/EX:310/251.1 —o
{ Execute
Close |
[Perform Search] Window
No. Item Description
Select the search range.
* to 500 nm
* to 600 nm
* to 700 nm
1] [Search Range] « to 800 nm

* Full Range
"9 Hint

When [to 500 nm] is selected, the excitation wavelength is set to
200 nm to 500 nm at intervals of 10 nm, and when the excitation
wavelength is 400 nm, the fluorescence spectrum is measured in

the range of 400 nm to 500 nm.

Intensity axis

After searching is complete, the intensity axis range for the intensity

settings contour can be set.
Enter the minimum and maximum values for the intensity axis of the
[Intensity] intensity contour. Values can be entered after searching is complete.
Effective range: -100000000 to 100000000 ([Minimum] to [Maximum])
[Set] The intensity contour is redrawn using the set intensity range.

Intensity contour

Displays an intensity contour of the captured data.

After searching is complete, drag out an area on the intensity contour to
enlarge the display.

To redraw the contour using the scale after measurement, click [Auto
Scale] on the right-click menu.

Current value
display at the
crosshair cursor

Displays the horizontal axis (fluorescence wavelength), vertical axis
(excitation wavelength), and intensity values corresponding to the crosshair
cursor position.

- [Execute] Execute a wavelength search.
- [Stop] Stop a wavelength search.
- [Close] Close the [Perform Search] window.

2.6.4
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When using the auto file function to automatically create filenames for saving after measurement, set
the rules for creating file information such as filenames.

0_

Settings

¥|Show new data set creation dialog when measurement is performed

(" Filename Sample Name
Name: V| Use sequential number
butoFile
Name: First No.: Step:
@) Use date Use sequential number SampleName + 1 1
FirstNo.: | 1
Sample ID

Sample: AutoFile_141107_202338.fs2f

| Use sequential number

=
Analyst Name

\
Name: First No.: Step: 9

SampleID + 1 1
( Comment Option
V| Use sequential number
e Name: First No.: Step:
Option + 1 1
OK ] [ Cancel
[Settings] Window
No. Item Description
Select this checkbox to display the [New Data Set Creation] window when
performing measurement.
Enter information such as sample information and the name to give the file
that is created after measurement.
[Show new data PP Reference "[New Data Set] Window"
(1) S?t lcreatlon "l' Hint Although the initial filename is created using the current date and
dialog when . time, this can be changed as required.
measurement is
performed]

! NOTE  The file is automatically saved after measurement is
complete. To change the filename after measurement,
click [Save As] on the [File] menu to rename and save
the file.

. Set the creation rules for the filename that is automatically created when
[Filename] .
saving a file.
[Name] Specify the text to use in the filename.
[Use date] Select this setting to use the date and time in the filename.
a [Use
sequential Select this setting to use a sequential number in the filename.
number]
[First No.] Specify the starting number when using a sequential number in the
filename.
[Sample] Displays a preview of the data filename.
(3] [Analyst Name] Enter the name of the analyst who created the data file.
(4] [Comment] Enter a comment for the data file.
[Sample Name]/
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[Sample ID]/
[Option]
[Use . Select this checkbox to use a sequential number for the sample name,
sequential .
sample ID, and option.
number]
e [Name] Enter text to use for the sample name, sample ID, and option.
[First No.] Ent_er the starting number to use for the sample name, sample ID, and
option.
Enter the number of steps from the starting number to use for the sample
[Step] .
name, sample ID, and option.
- [OK] Save the automatic filename settings.
- [Cancel] Cancel the automatic filename settings and close the [Settings] window.

m[New Data Set] Window

! NOTE  Since the file is automatically saved after measurement is complete, the filename cannot
be changed at this point.
To change the filename after measurement, click [Save As] on the [File] menu to save the
file under a different filename.
Data information such as the sample name and comment can be changed from [Properties]
on the [File] menu.

M Reference "[File Properties] window"

MNew Data Set
Filenarne: e
Data Set Mame: FawData
Analyst:
Sample Mame:
Sample [D:
Option(0]:
LComment; -
13
[ QK. ] | Cancel
[New Data Set] Window
Item Description
Displays the filename.
Although the default filename is created using the current date and time, this
can be changed as required.
Click [...] to display the [New File Name] window.

file:///C:/Users/Marcia/AppData/Local/Temp/~hh21AC.htm

28/6/2019



2 Window Layout Page 24 of 30

Mew File Name @
Look in Data - 0> E

[ Narne Date modified Type

T

Recent Places

Desktop
LiEIraries
[Filename] A
Computer
“
h 4 T r
Network
File name [File 150303 175619 - Open
Files of type: ISpEdn_lm File (" fs2%) v| | Cancel ]
[New File Name] Window

The save destination can be selected on the [New File Name] window.
The default save destination is the folder specified at [Destination Folder] on
the [Tools] menu.

M Reference "2.2.4 [Tools] Menu"

Enter the name of the analyst who created the data set.

[Analyst] If an analyst name is already set in the data set, it is read and displayed.
[Comment] Enter a comment for the dat.a set. - )

If a comment is already set in the data set, it is read and displayed.
@ Click this icon to enter the current date to the cursor position in the entry field.
@ Click this icon to enter the current time to the cursor position in the entry

field.

Save the filename settings.
[OK] If the window was displayed at the start of measurement, pressing this button
starts measurement.

Cancels the filename settings and closes the [New Data Set] window.
[Cancel] If the window was displayed at the start of measurement, pressing this button
cancels measurement.

2.6.5 [Quantitation File Setting] Window/[Photometric File Setting]
Window

Quantitation File Setting

Filename:  C:ARF-Data\Data\File_141020_100039 faqf e BE
Analyst: RF User

Comment:  for Help

[Quantitation File Setting] Window
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Photometric File Setting
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Filename:  C:\RF-Data\D atahFile_150203_092208.fquf EI E @
Analyst: AF Used
LComment:
[Photometric File Setting] Window
Item Description
Displays the name of the quantitation file or photometric file.
Although the default filename is created using the current date and time, this
can be changed as required.
Click [...] to display the [New Filename] window.
[7] New Filename @
Look in Data - @2
== Narne o Date modified Type
o
Recent Places
Desktop
[Filename]
Libraries
LY
Computer
=
@ ;
Metwork
File name [File 150303 175758) - Open
Files of type: [ Quaniation (7} ~] [ Cancel |
[New Filename] Window
The save destination can be selected on the [New Filename] window.
The default save destination is the folder specified at [Destination Folder] on
the [Tools] menu.
M Reference "2.2.4 [Tools] Menu"
[Analyst] Enter the name of the analyst who created the data file.
¥y If an analyst name is already set, it is read from the data file and displayed.
[Comment] Enter a comment for the data file.
If a comment is already set, it is read from the data file and displayed.
@ Click this icon to enter the current date to the cursor position in the entry field.
@ Click this icon to enter the current time to the cursor position in the entry
field.
[OK] Save the filename settings.
[Cancel] Cancel the filename settings and close the [Quantitation File Setting] window

or [Photometric File Setting] window.
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2.7 Photometer Status

EX EM
350.0 350.0

105.7

« Arc Lamp

ON (200 hours)
v Integrating Sphere

Photometer Status

Page 26 of 30

No. Item

Description

[EX]

Displays the excitation wavelength.

[EM]

Displays the fluorescence wavelength.

(2] Intensity value

Displays the current fluorescence intensity at the wavelength displayed at

! NOTE  The fluorescence intensity before spectrum correction is
displayed.

Photometer
Status

Displays the lighting state and cumulative operating time of the light
source lamp and the status of any installed options.

[Arc Lamp]

This is displayed when connected to an instrument installed with an arc

lamp (not shown when disconnected).

. 'vJ‘ (green): Arc lamp can be used

. '! Y (vellow): Arc lamp has exceeded its service life (RF-5300
series: 500 hours, RF-6000: 2,000 hours)

. O (red): Arc lamp is lit even though it should be unlit

* ON/OFF: Lamp lit/unlit display

+ Time: Cumulative operating time of arc lamp

[Integrating
Sphere]

This is displayed when connected to an instrument installed with an
optional integrating sphere (not shown when disconnected).

Y 4 (green): Integrating sphere connected

[Sipper]

This is displayed when connected to an instrument installed with an
optional sipper (not shown when disconnected).

Y 4 (green): Sipper connected

e 2.7.1 [Photometer Status Properties] Window

2.7.1 [Photometer Status Properties] Window

Right-click on the Photometer Status and select [Properties] to display the Photometer Status properties

window.

m[Font] tab
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Photometer Status Properties @
| Fort | Displayed Digts |
Font: Fort style: Size:
TE Bold 1
iAngsana New - :Regular - !ﬁiA_
| AngsanaUPC | alic |12 |
| Aparsjta Bad IR
| Arabic Typesetting | Bold Halic |16
Aval . <18 -
| Arizl Blark |20
Text Color: Background Color:
I white - I Elack -
Sample

EX350.0 EM350.0 -0.0

oK | Cancel

[Photometer Status Properties] Window - [Font] Tab

Page 27 of 30

Item Description
[Font] Set the font of the text to display in the Photometer Status.
[Font style] Set the style of the text to display in the Photometer Status.
[Size] Set the size of the text to display in the Photometer Status.
[Text Color] Set the color of the text to display in the Photometer Status.
[Background Color] Set the background color of the text to display in the Photometer Status.
[Sample] Displays a sample of the selected font.
[OK] Accept the display settings for the Photometer Status.
[Cancel] Cancel the display settings for the Photometer Status.

m[Displayed Digits] tab
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Photoemeter Status Properties
[Font | Displayed Digs |
Decimal Places

Excitation Wavelength:

Emission Wavelength:

Measurement Value:

Sample

EX350.0 EM350.0 -0.0

.

[Photometer Status Properties] Window - [Displayed Digits] Tab

Item

Description
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[Excitation Set the number of decimal places used to display the excitation wavelength.
Wavelength] Selection options: 0, 1

Set the number of decimal places used to display the fluorescence wavelength.

[Emission Wavelength] Selection options: 0, 1

Set the number of decimal places used to display fluorescence intensity
[Measurement Value] (analog values).
Selection options: 0, 1, 2, 3

[Sample] Displays a sample of the set number of decimal places.

2.8 Parameter View

The information displayed in the parameter view differs depending on the window mode (measurement
mode or view mode).

e 2.8.1 Measurement Mode
e 2.8.2 View Mode

2.8.1 Measurement Mode

The currently set parameters can be checked, edited, and saved in this mode.

Because the graph view (for displaying calibration curves and sample graphs) is also displayed in the
quantitation and photometric applications, select the [Parameter] tab to change to and display parameter
information.

M Reference . Quantitation application: "5.3 Parameter/Graph View"

* Photometric application: "6.3 Parameter/Graph View"

[ Settings... ] [ Load...

Parameter Value

[Measurement]

Spectrum Type Emission

EX Wavelength 350.0 nm

EM Wavelength Start 350.0 nm

EM Wavelength End 450.0 nm

Data Interval L.0nm

Scan Speed 6000 nm,fmin

[Instrument]

EX Bandwidth 3.0nm

EM Bandwidth 5.0 nm

Sensitivity Auto

[Attachment]

Attachment MNone

[AutoPrint]

AutoPrint Yes

Report File C:\RF-Data‘\Report\Spect..
P i +

Parameter View (Measurement Mode) - Spectrum Application

Item Description

Display the measurement parameters settings window.
Use this window to edit the currently set parameters and save the settings as a
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[Settings]

measurement parameters file.

M Reference

¢ "3.3 [Spectrum Mesurement Parameters] Window"

"4.3 [3D Spectrum Mesurement Parameters] Window"

"5.4 [Quantitation Measurement Parameters] Window"

"6.4 [Photometric Measurement Parameters] Window"

"7.3 [Time Course Measurement Parameters] Window"

Page 29 of 30

[Load]

parameters file and load parameter settings.

Display the [Open] window. Use this window to select a saved measurement

Parameter display area

instrument.

Displays the settings of the measurement parameters currently set for the

2.8.2 View Mode

Parameter |H\shory I Summary I Event |
Parameter Value
[Measurement] | Parameter | History |5ummar\-I I Event |
WL1 =5 =
Description | Date/Time | User I
EX Wavelength Created new data set. [ — = _' =
EM Wanelength AutoFie_20150203_221{ | Parameter [ History | Summary [Event
Timing Mode 2.fttc - RawData. Scmare Informatioq -
Time Uit e R parameter [ History | summary | Event |
Total Time ! No. Date and Time Length
Cyde Time Data Information
) Datais: igi 1 2/3/201510:19:02 PM | 00:00:00 | St:
MNumber of Readings . -
e Sample Name:  SampleName00 2 2/3/201510:19:12 PM | 00:00:21 | Inje
ecord Events Sample [D: D001
Option: Option001 | 3 2/3/2015 10:19:41 PM | 00:00:17 | Ad
Analyst: RF User
(Instrument] Date/Time: 02/03/2015 10
Light Source Comments:
Signal Processing
EX Bandwidth insgumen: Em"‘;gqgl
= nstrumen lame:|
EM Bandwidth Instrument Type:RF-6000 Series
Sensitivity Model (5/M): RF-6000 (H2_2|
Accumulation Time
[Attachment]
Attachment
TauitPrint]
[
Parameter View (View Mode)
Item Description

[Parameter] tab

Displays the measurement parameters used when measuring the active data
set.

[History] tab

Displays the data history of the active data set.

[Summary] tab

Displays a summary of the active data set.

[Event] tab

Only displayed in the time course application.
Displays an event record of the active data set.

B NOTE  The [Event] tab is only displayed when the [Record Events]
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checkbox is selected on the [Measurement] tab in the [Time
Course Mesurement Parameters] window and the measured
data set is set to active.

mRight-click menu of the parameter view

Click the right mouse button on the parameter view to display the following right-click menu.

The items displayed on the menu differ depending on the tab.

Menu

Description

[Parameter] tab

[Print]

Perform a quick print.
Set or change the report file to use via [User Settings] on the [Tools] menu.

» Reference ¢ "[User Setting] window (common)"

« "[User Settings] window (spectrum application)"

¢ "[User Setting] window (3D spectrum application)"

¢ "[User Settings] window (quantitation application)"

¢ "[User Settings] window (photometric application)"

¢ "[User Setting] window (time course application)"

[Properties]

Displays the [Parameter Properties] window. Whether to display or hide items
on the parameter tab can be selected for each parameter group.

Parameter Properties

Check items to be shown.

[ Measurement

[ OK ] [ Cancel ]

[Parameter Properties] Window (Spectrum Application)

[History] tab/
[Summary] tab

[Copy]

Copy the selected items to the clipboard.

[Select All]

Select all selectable items.
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